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1. Introduction

Note: Go to Section 2.5 for a Quick Tour of major features and functions of CTGROWTH.

1.1 BACKGROUND

CTGROWTH was developed by Maurer Engineering Inc. under sponsorship of the joint-industry project
DEA-67 To Develop and Evaluate Coiled-Tubing and Slim-Hole Technology. This model is part of a complete
coiled-tubing analysis suite, and will be incorporated into the integrated package CTPRO in the future.
CTGROWTH is written in Visual Basic 5 for use with IBM-compatible computers. It runs in Microsoft
Windows 95 or later versions.

C
de‘“formed during routine usage. Each trip into a well is accompanied by three bend/straighten cycles. CT is
1¥ straightened (unbent) as it is spooled off the reel, 2) bent onto the gooseneck, 3) straightened as it comes
“'off the gooseneck toward the injector, and then travels into the well. (Only rarely will CT be plastically
i deformed while in the well.) On the trip out of the well, the three bending events are repeated in reverse order.
T After a number of trips in and out of the well (typically tens to hundreds), a string of CT will fail due to fatigue.
<Fhe'number of cycles before failure is related to CT metallurgy, equipment dimensions, and other factors, and

S can be predicted and tracked with the MEI program CTLIFE.

iled tubing (CT) has an unusual consideration with respect to engineering design in that it is plasticaily

Plastic deformation of CT can also be accompanied by diametral growth (““ballooning”) whereby the OD of
the CT increases slightly with each trip into the well. Internal pressure during bending is required for this to
occur, and the impact is greatest at pressures greater than about 2000 psi. CT diametral growth causes
incompatibilities with deployment equipment (the CT will not fit through the stripper bushings), and
continuous use could cause severe mechanical damage to the CT. Accurate predictions of diametral growth
are necessary for both safety and reliability.

1-1 © 1998 Maurer Engineering Inc.



Chapter 1. Introduction

It is important to recognize that, while plastic fatigue and diametral growth are related phenomena, there is no
direct correlation between these two failure mechanisms. Fatigue limits, diametral growth limits, or a
combination of the two may dictate when a particular string is retired.

Theoretical Basis

MEI developed CTGROWTH to meet the industry need for a reliable model for predicting CT diametral
growth., The program was developed based on Halliburton’s growth model and test data from Precision Tube
Technology. Halliburton developed their growth model based on full-scale test data of CT generally larger
than 2-in. OD. Precision Tube Technology measured diametral growth on a standard fatigue test fixture for
CT smaller than 2-in, OD. For both the Halliburton and Precision Tube Technology tests, the CT was rotated
at regular intervals as diametral growth accumulated.

In addition, Quality Tubing’s fatigue data were used as another calibration reference. CTGROWTH is related
to MED’s CTLIFE model for estimating CT fatigue life. CTLIFE was developed based on data from Quality
Ihbmg and Halliburton. Quality Tubing recorded the growth at fatigue failure for a full series of fatigue tests.
&-g@eck against these data was also performed for fine-tuning CTGROWTH.

A cdmpa:ison of test results and CTGROWTH predictions shows good agreement for OD growth up to 10%
* above nominal OD. A typical criterion applied in the field is to retire a string (or section of a string) when
gTOWth exceeds 6% over nominal OD. Based on these practical considerations, CTGROWTH predicts OD
Eg'rib,;vth only up to 10%. For predictions of growth greater than 10%, please contact MEL

2" _FEATURES OF CTGROWTH

7T GROWTH 1 is anew release in the leading-edge suite of CT operations design software developed by MEL
The “look and feel” of the program is user-friendly and intuitive. Convenient icons and tabs can be used to
quickly navigate through the program. Data-file management is simple, and options for customizing graphics

and producing professional-style printouts are included.
Another significant feature is a complete Help system. Descriptions and instructions are provided for every

input and output screen by clicking or pressing [F1]. The Help system is also context sensitive to allow

intuitive navigation by pointing and clicking the mouse on the area of the screen where the user’s question
originates. Most of the information provided in the User’s Manual is also contained in the Help system.

CTGROWTH runs in the Microsoft Windows 95 and Windows NT environments. As a true 32-bit
application, the program is not compatible with Windows 3.x. 1t is assumed that the user is familiar with
basic operation in the Windows 95 environment. For comprehensive information about Windows, the reader
is directed to other texts.

Important technical features of the CTGROWTH Coiled-Tubing Diametral Growth Model include:

« Calculates CT fatigue cycles with reference to a standard CT fatigue test fixture

« Calculates CT fatigue trips in/out of a well with reference to a standard wellsite rig-up
= Checks the burst pressure criterion for a given CT and warns the user if it is exceeded
» Calculates diametral growth (up to 10%) for CT cycled on a bending machine

» Calculates diametral growth (up to 10%) for CT cycled at the well site

1-2 © 1998 Maurer Engineering Inc.



Chapter 1. Introduction

- Sensitivity analyses allow the user to evaluate the impact of changes in CT OD, wall thickness,
material grade, internal pressure, and bending geometry on diametral growth

+ Provides a choice of systems of units, including English, SI (metric), or any user-specified custom
combination

The Output Window provides a number of informative graphs and reports that may be printed or stored to a
disk.

1.3 COPYRIGHT AND DISCLAIMER

This software and manual are copyrighted (©1998) by Maurer Engineering Incorporated. The copyright
agreement and usage restrictions are described on the Licensing window that is accessed under the Help menu
by selecting “About...” =+ “Licensing...” (see below). By selecting [Accept] at the bottom of this screen,
the user signifies that he agrees to abide by the restrictions as presented. No warranty or representation,
~either express or implied, is given with respect to this program and documentation, including their quality,

performance, merchantability, or fitness for a particular purpose.

, CTGROWTH 1.0 ~— Version No.

COILED-TUBENG DIAMETRAL GROWTH MODEL

DEA67
Project to Develop and Evatuate Coiled-Tubing and Slim Hole Technology

By
Maurer Engineering Inc.

This copyrighted 1998 confidential computer program and manual are for the sole
use of Participants on Drilling Engineering Association Project DEA 67 and their Usage
affiliates, and are not to be disclosed to other parties. Data output from the ..
pragram may be disclosad 1o third parties. Participants and thelr affiliates are Restrictions
free to make copies of this program and m | for their in-h use onfy.

i Maurer Engineering Inc. makes no warranty or representation, either express :
it or implied, with respect 1o the program or documentation, including their quality, Disclaimer
i performance, merchantability, or fitness for a particular purposa.

International keyboard users - see Appendix A of User's Manual.

coep

1-3 © 1998 Maurer Engineering inc.
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2. Getting Started

2.1 HARDWARE AND SYSTEM REQUIREMENTS

CTGROWTH is written in Microsoft Visual Basic® version 5. It runs in Microsoft Windows 95 or Windows
NT (or later versions). As a 32-bit application, WELOPT is not compatible with Windows 3. The minimum
hardware requirements are:

+ IBM-compatible machine with 80486 processor

+ Hard disk (about 10 megabytes of storage space required)
+ Mouse

*» VGA or compatible display

2= INSTALLING CTGROWTH

P;;(")grya-m Disks

e  GTGROWTH s shipped on two 3%-inch disks (or one CD). The CTGROWTH executable file

(CTGROWTHIO EXE) should be placed in a new folder (default “C:\MENCTGROWTH™) along with the
vwcxmnple data file CTtestl.CG1. All of these procedures will be accomplished during the set-up procedure
. descrlbed below.

Backup ‘Disks

" It is recommended that the original disks be kept as a backup set and stored in a safe location, and that work
dlsks be made from them. In Windows 95, run Windows Explorer, double-click “My Computer”, single-click
the icon for your floppy drive, and select “Copy Disk” from the File menu.

Installation

The following procedure will install CTGROWTH from the floppy drive onto the working directory of the hard
disk (e.g., copy from A: floppy drive onto hard drive directory CAMENCTGROWTH).

1. Choose Run... from the Start menu. Then type “A:SETUP.”
2. Follow the on-screen instructions.

After set up, a new folder (“MEI Applications™) may be created {depending on your choice during installation)
with the shortcut to CTGROWTH and other MEI programs.

Note: To move other previously installed MEI applications into this folder, select Start — Settings —
Taskbar... ~ Start Menu — Programs — Advanced. Then double-click “Programs” to display the folders
in your Programs menu. Drag and drop shortcuts to other MEI programs into the MEI Applications folder.

2-1 © 1998 Maurer Engineering Inc.



Chapter 2. Getting Started

2.3 UNINSTALLING CTGROWTH

Should it ever be necessary to remove CTGROWTH from your computer, access the Windows Add/Remove
Programs feature (rather than simply deleting the CTGROWTH folder). This feature is activated by running
Start — Settings — Control Panel — Add/Remove Programs and selecting CTGROWTH from the list of
programs currently installed on your computer.

Using this procedure clears the library registry in the Windows system folder and erases the corresponding
library files that are not stored in the CTGROWTH directory.

2.4 RUNNING CTGROWTH

To launch CTGROWTH,

select it from the MEI
—Applications program group
under the Program Menu (or
= gther program group you
0 »assigned during setup).

The :design and operation of
input windows in
o .CTGROWTH are described in
M.MW”C“};apter 3. Output windows

“and’ features are discussed in

.Lhapter 4. For assistance with

the program, contact MEI
using information presented in
Chﬁpter 5. Common problems
and solutions are described in SFMSLAE
Appendix A.

2.5 QUICK TOUR OF CTGROWTH

The following quick tour will give the new user a rapid overview of the basi¢ structure, features and functions
of CTGROWTH version 1.

Install:

1. Start Windows 95
2. Insert CTGROWTH Disk | in drive A:
3. Choose Run... from the Start Menu.

4. Type A:SETUP and press Enter. Follow the on-screen instructions.

2-2 © 1998 Maurer Engineering Inc.



Chapter 2. Getting Started

Run:

5. Launch CTGROWTH. Select CTGROWTH from the MEI Applications folder under Start Menu —
Programs.

Input:

e
6. In the Main Window, choose “Open File...” from the File menu (or click E] ).

7. From the Project File Open dialog box, select “CTTest.CG1” in the file list box, and click OK.

8. Click the “Full-Scale Cycling” tab. Examine the CT parameters on the page. Click on the drop-down
boxes and change any parameters desired.

. «Click [Calculate] on the lower right section of the page (or click the run icon & . The progress of the
calculation will be displayed on the right end of the icon toolbar.

. After the QOutput Window is opened, an informational text message is displayed within the graph area that
" indicates the number of bending cycles the current string can withstand before fatigue failure. Fatigue
failure for this example is predicted to occur gffer the CT diametral growth reaches 10%; therefore, growth

- will be presented in the output graphs up to 10%. (If fatigue failure is predicted to occur before the CT
diametral growth reaches 10%, growth will be presented in the output graphs only up to the point of

r—

fatigue failure.)

1 l ‘Review the graph and table in the Output window that display diametral growth per trip into the well.

' . Click to print out the graph and tabulated results.

13. Click [Sensitivity Analysis] or iﬁ.lto analyze the sensitivity of diametral growth to changes in tubing OD,
wall thickness, material grade, pressure and bending radius.

14. Double-click any graph to enlarge it to full screen. Double-click again to restore the multiple-graph
display. Click to print a copy of the active graph.

15. Click to return to the Input window. Change any parameter by pulling down the options in the drop-
down box. Click the run icon : 'ﬂ, to calculate growth based on the new parameters.

16. Finally, click to return to the Input window. Click “Exit” from the File menu or ﬂ in the upper
right corner of the screen to close the program.

2-3 © 1998 Maurer Engineering Inc.
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3. Input

3.1 REQUIRED INPUT DATA

Data input is very simple for modeling CT diametral growth. Required data include tubular geometry and
metallurgy, gooseneck radius and spool diameter (or bending fixture radius), and internal pressure. An option
is also provided to document any specific project (company name, well description, date, etc.). Documentation
data will be printed along with any output graphs and tables.

Project Information:

1. Project description (company name, project name, wel] location, etc.) (optional)

Tubular Data:

. Qﬁ Tubing OD, wall thickness, material grade (yield strength), and Young’s Modulus

é;ftling';;Parameters:

TS trips into a well is the reference environment, reel diameter and gooseneck radius are required. If

-cycling is referred to the standard bending test fixture, the bending form radius is required.

" rarely be the case since bending normally occurs with the CT exposed to the atmosphere.)

Data can be entered and displayed in English or metric units, or in a custom combination of units defined by

;‘.h:e user and stored on disk.

3.2 INPUT WINDOW

In the [nput window of CTGROWTH, there are three different pages for input data. Each is accessed by
clicking on its tab below the icon tool bar. Functions and parameters on each screen are described in the
sections which follow.

3-1 © 1998 Maurer Engineering Inc.



Chapter 3. Input

3.2.1 Project Page

@ ‘Menu Bar. The function of the pull-down menus in CTGROWTH is similar to that in other Windows

’applications. A description of all functions and features is presented later in this chapter in section 3.2.4.

' Tool Bar. Tool-bar icons can be used to quickly access commonly used functions. The icons are short-

-« cuts for menu options. The functions of the icons are:

New Project. Clears all input data.
Open File. Activates the open file window.

Save. Saves all input data to the current file name. If the project is new, will automatically
activate the Save As... window.

Print. Activates the print options window.
Run. Initiates calculations. Same as [Calculate]. Progress can be monitored on the Status Bar.

Output. Goes to output screens without recalculating. Not active if the calculations have not yet
been performed.

Units. Opens the Units Selection window (see Section 3.2.4). The user can select English, SI,
or any custom combination of units.

Help. Opens the Help system for CTGROWTH keyed to the currently displayed window. Same
as [F1]. Altematively, select “Help Topics...” from the Help menu to open Help at the table of
contents.

Calculator. Causes the Windows utility calculator to pop up.

3-2 ©® 1998 Maurer Engineering Inc.



Chapter 3. Input

@ Page Tabs. Switching between the three input screens for entering or checking data is simple — just click

on the corresponding tab.

@ Project File. The project file currently in use is displayed. CTGROWTH files are automatically assigned
the extension .CG1.

® Project Description. These data provide specific information about the project to identify the company,
project name, well location, date, and miscellaneous comments. This information will be printed in a
heading block in all printouts of graphs and tables. Any or all of these items may be ieft blank if desired.
The function of the program will not be affected. The maximum string length for each entry is 50
characters.

@ Calculation Status Bar. After the input data are entered, the calculation is launched by clicking the run
R icon ;*] or the [Calculate] button. Prior to beginning the calculations, the program automatically checks

the data for errors. Errors include parameters that are outside the allowable range as specified in Section
3.3. Asthe calculations are performed, the ongoing status is displayed in this bar with a percentage
_ complete indicator.

3.2.2.Bending Fixture Cycling Page

] {;J‘gwo basic options are provided for analyzing CT growth. The first option, Bending Fixture Cycling, is
@“:_p‘rﬁowded for users interested in laboratory analysis of growth, correlation to other laboratory data, etc. Growth
is described with direct reference to the standard CT fatigue test fixture (these fixtures are operated by CT
#““manufacturers and other companies). The bending radius of the curved form on the test fixture is required
" input. In addition, results are presented as bending cycles that represent a single bend/straighten cycle as

. “w--measured in the laboratory.

" The second option, Full-Scale Cycling (next section), will be preferred by most users. This calculation option
is based on full-scaie rig geometry. Required input includes the reel diameter and the gooseneck radius.
Output results are presented as trips in and out of the hole. Each bending trip represents three bend/straighten
cycles as is normally considered for field operations (that is, two bending cycles at the gooseneck radius and
one bending cycle at the reel diameter).

3-3 © 1998 Maurer Engineering inc.



Chapter 3. Input

FACTGROWTH 1.0-{Man Window]

1.508

- prior to calculation. The most common options are provided for convenience in 1.000

drop-down lists. Click on the arrow E to view the options provided. Otherwise, )I %g

fype in any desired value. The allowable range of values for each parameter is {1,750

" defined in Section 3.3.

T .

2375
2875
3.500

: = @ Bending Radius. Enter the desired bending radius as it applies to the standard CT

¢ ‘bending machine.

©) Equipment Schematic. Parameters required for calculating diametral growth and fatigue life are defined

schematically for the user’s reference.

3.2.3 Full-Scale Cycling Page

Two principal options are provided for analyzing CT growth. The first option, Bending Fixture Cycling (see
previous section), is provided for users interested in laboratory analysis of growth, correlation to other
laboratory data, etc. Growth is described with direct reference to the standard CT fatigue test fixture {operated
by CT manufacturers and other companies). The bending radius of the curved form on the test fixture is
required input. In addition, results are presented as bending cycles that represent a single bend/straighten cycle
as measured in the laboratory.

The second option, Full-Scale Cycling, will be preferred by most users. This calculation option is based on
full-scale rig geometry. Required input includes the reel diameter and gooseneck radius. Output results are
presented as trips in and out of the hole. Each bending trip represents three bend/straighter cycles as is
normally considered for field operations (that is, two bending cycles at the gooseneck radius and one bending
cycle at the reel diameter).

3-4 © 1998 Maurer Engineering Inc.



Chapter 3. Input

<. .type in any desired value. 1.500
- 1.750

) Bending Radius. Enter the diameter of the CT reel and the radius of the rig 5 375
gooseneck. 2:8?5
3.5600

) Equipment Schematic. Parameters required for calculating diametral growth and

fatigue life are defined schematically for the user’s reference.

3.2.4 Input Window Menus

The menu system used in CTGROWTH is typical of Windows applications. Most functions are self-
explanatory. There are four menus in the Input window of CTGROWTH: File, Run, Utilities and Help.

File Menu

The File menu contains commands for creating, retrieving, saving and printing input 2
data. The functions of the individual menu options are:

1. “New?” clears the Project page. CT parametric data are not affected.

2. “Open..” opens a dialog box for exploring the file system for input files with the |
extension “.CG1.” :

3-5 © 1998 Maurer Engineering Inc.



Chapter 3. Input

3. “Save” replaces the previous version of the input data file with the current modified data. No prompt is
given before overwriting the previous version of the file.

4. “Save As...” saves the current version of the input data under a different name. A dialog box is opened
to let the user specify the drive, directory, and name of the project file.

5. “Print” prints a form displaying all current input data and parameters.

6. “Exit” concludes the current session. CTGROWTH will prompt for saving the project file if data have
been changed and not yet saved.

Run Menu

The Run menu is used to launch CTGROWTH calculations. Click Start and Outout k F5
“Start” after all input data are entered. CTGROWTH will check for —
errors in the data (e.g., parameters outside the allowable range (see Section 3.3), internal pressure greater than

-burst pressure ratings, etc.) prior to performing the calculations. The [Calculate] button or the run icon - :g,l
— can also be used to launch the calculations.

' The Calculation Status Bar (located on the right end of the icon tool bar) will display the progress of the
calculation (from 0 to 100% complete). After the calculations are completed, the Output window displaying
the results will be loaded automatically.

Y DTRSRETET
e,
I ]

Utﬁiﬁ@s Menu
e -

w O e

“I'hé Utilities menu includes:

"5 “Units...” opens the Units selection window (see below). Same as ﬂl

2. E‘Calculator” opens the Windows utility calculator. Same as Ell

3-6 © 1998 Maurer Engineering Inc.



Chapter 3. Input

Units Selection Window

Table. The user cannot edit this table directly (indicated by the yellow background). Allowable opticns
S for each quantity are accessed by pulling down the drop-down box attached to each quantity.

"@ Custam Units Control Buttons. 1f any changes are made to the default English or S systems of units by

wse lecting another option from one or more pull-down boxes, the new custom system will need to be saved

“for future use. Use the [Save] button for new custom systems or updates to previously created systems.
The [Save As...] button is used when a new combination of units is designed, and the user wishes to save
it separately, rather than overwriting the previous custom system. Both save buttons will cause a save
dialog box to pop up. Custom systems of units are stored as * UNT files.

The [Print] button will print the Units Selection Table for documentation or reference. (This functions
only after a save.)

@ System of Units Selection Buttons. These buttons select entire systems of units, which then appear in the

table, and in CTGROWTH screens and graphs. The [Other] button will display the file names of the
custom systems previously created and stored.

The name of the currently selected system of units is displayed in the upper left comer of the Units
Selection Window (“Default English” in the figure above).

3-7 © 1998 Maurer Engineering Inc.



Chapter 3. Input

@® Numeric Display Format Table. The number of digits displayed for each parameter can be adjusted by

the user. The number of zeroes after the decimal point for each quantity will be used as standard for the
input entries and for printouts.

Within the decimal section of the number {which defines how many decimals are displayed), a zero
denotes a “hard” digit (always displayed) and a “#” denotes a “soft” digit (displayed if required).

@ Control Buttons. These buttons control operations for the entire Units Selection window. [OK] accepts

the current settings after any changes are made and then returns to the previous window. [Cancel] ignores
any changes made since this Units window was activated and returns to the previous window. [Undo All]
deletes all changes made since this Units window was activated, but stays in the Units window for further
editing.

Help Menu

The Help menu provides assistance for running CTGROWTH and presents
- -various parameters describing the user’s computer.

“Help Topics...” launches the CTGROWTH Help system from the Table
‘of Contents. Alternatively, clicking - ?l or pressing [F1] opens the Help

o system directly on a description of the current screen.

“Assistance...” opens a pop-up box which displays MEI's address, phone
- number, e-mail address and other information. Use these contacts to
obtain additional help with CTGROWTH.

¢ ==+ 3. “About...” opens the About pop-up box, which displays the version number of CTGROWTH along with
- hardware in the user’s computer. Click “Licensing...” to view a summary of the restrictions for copying
* the program and manual, and the program disclaimer.

4. “Feedback..” opens a special screen form for documenting specific bugs, problems, etc. and
communicating with MEI. The form can be printed for faxing or saved to disk and attached to an e-mail
routed to mek@maureng.com.

3-8 © 1998 Maurer Engineering Inc.
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PARAMETER LIMITS

Chapter 3. Input

CTGROWTH was developed based on Halliburton’s growth model (which was itself based on full-scale test
data for large CT 2-inch and above) and laboratory data from Precision Tube Technology for CT less than 2
inches. The model was also calibrated by comparison with a wide range of test data from Quality Tubing. For
more discussion on the theoretical background, see “Theoretical Basis™ in Section 1.1.

Limits are set within CTGROWTH for each of the input parameters, These limits are set by the program to
avoid extrapolating the results to configurations significantly outside the range for which experimental data

were available.

The maximum and minimum allowable values for each parameter are listed in the table.

ALLOWABLE PARAMETER VALUES

CT OD (in./mm) 0.75/19.1 3.50/88.9
Wall Thickness (in./mm) 0.08/2.03 0.250/5.72

Young’s Modulus (psi/kPa)

18.5x 105/ 128 x 10°

35x10°/241 % 10°

Yield Strength (psi/kPa) 70,000 / 482,650 100,000 / 689,500
Internal Pressure (psi/kPa) 1,000/ 6,895 7,000/ 48,265
Reel Diameter (in./mm) 48 /1,219 240 /6,096
Gooseneck Radius (in./mm) 72/1,829 180/4,572
Bending Form Radius (in./mm) 48/1,219 120 /3,048
39 © 1998 Maurer Engineering Inc.
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4. Output

4.1 MAIN OUTPUT WINDOW

CTGROWTH diametral growth calculations are summarized in the Main Output window. Presentation formats
include a graph and a table. The uppermost value presented is based on the more restrictive of two limits. The
primary limit is that growth is not allowed to exceed 10% of nominal OD. Many operators and service
companies impose a limit of about 6% on CT growth based on equipment constraints (i.e., fitting the CT
through the gripper blocks and stripper). Based on these considerations, CT growth of 10% was chosen as a
practical upper limit for all analyses. Experimental data above 10% were also excluded from the correlations
to allow a closer fit to data in the range of interest (0-10%).

The second limit applied to the output data presentations is fatigue failure. If the CT is predicted to fail from
fatigue before the diameter grows by 10%, then growth is shown only up to the point of fatigue failure.

O;itput Graph and Table

CT Diametral Growth
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@ Menu Bar. The pull-down menus in CTGROWTH output are used to modify output presentation, export

data, select options for graph design, and several other useful functions. A description of functions and
features of the output menus is presented in Section 4.1.2.

@ Tool Bar. Tool-bar icons can be used to quickly access commonly used functions from the menus. The

functions of CTGROWTH's output window icons are:
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Chapter 4. Output

Print. Prints the current graph and table.
Save. Saves the current graph and table to disk in metafile format.
Input Window. Returns to the Input window for reviewing and/or editing input data.

Sensitivity Analysis. Opens the Sensitivity Analysis window. See Section 4.2.

Help. Launches the CTGROWTH Help system keyed to the current screen. Same as [F1].

= Calculator. Pops up the Windows utility calculator.

@ Graph of CT Growth. Results

of calculations for the current CT Diametral Growth CT Diametral Growth
input paramCters are dlsplayed / 00« 1.500 n). WLipl Thao kness = 0.109 () /7 00« 2379 ¢n) Wisl Thickoveas = 0.123 Gn)

10

graphically. If the calculation

81 1iips infout o the hole! 17 ripa ot of the hole!

10
|uo‘¢crs.,.pm..am..uw L7 J \‘Nnegc‘"aiguldunﬂmdlwl

*“'was launched from the Bending
.. Fixture Cycling page (see
.- :Section 322), the x-axis

B 2

/

CT Dlametral Growth %

CT Diametral Growth %

_parameter will be cycles {one f //
.. bend/straighten sequence). If the A4 A 2 /|
_calculation was launched from . E,w’_,_uﬂ'_erd_l . ﬂ;ﬂﬂ‘
the Full-Scale Cycling page (see T L
) Section 3.2.3), the x-axis will be
frips (one complete trip infout of

Number of Trips Number of Trips

“the hole consisting of three bend/straighten sequences).

# 7 The maximum y-axis value is set based on the fatigue limit or the growth criterion of 10%. If fatigue
P failure is predicted to occur affer the CT diametral growth reaches 10%, growth will be presented in the

s output graphs only up to 10%. If fatigue failure is predicted to occur before the CT diametral growth

" reaches 10%, growth will be presented in the output graphs only up to the point of fatigue failure.

@D Table of CT Growth. Tabulated output from CTGROWTH is presented for evaluation. If the calculation

was launched from the Bending Fixture Cycling page (see Section 3.2.2), the independent parameter will
by cycles (one bend/straighten sequence). If the calculation was launched from the Full-Seale Cycling
page (see Section 3.2.3), the first column will be f#ips (one compiete trip in/out of the hole consisting of
three bend/straighten sequences).

4.1.2 Output Window Menus

The menu system design used in CTGROWTH is similar to other Windows applications. Several of the most
commonly used menu functions can be easily accessed through the tool bar icons (see previous section). There
are three menus in the Main Output window of CTGROWTH: File, Sensitivity, and Help.
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Chapter 4. Output

File Menu

The File menu contains commands for printing, exporting, and
saving output data. The functions of the individual menu
options are:

1. “Save Graph..” opens a dialog box. The user specifies
the drive, directory, and the name of the image file. The
image of the graph is written to disk as a metafile
(*.-WMF).

2. “Save Table..” opens a dialog box for saving the

tabulated results. The user can specify the drive,
directory, and the name of the image file (extension .out),
The table is written to disk in ASCII format with space delimiters.

—3-~ “Copy Graph to Clipboard” copies the output graph to the Clipboard in metafile (*. WMF) format.

4,  “Print Graph” prints a high-quality image of the main output graph at the full resolution of the printer.
 CTGROWTH offers the option of printing in color. After a print job is launched, a second box will pop

i

e e up for selecting a color printer.

= 3 “Print Report” prints a complete summary of the output data including input data, a graph of CT growth

" with bending cycles, and a table of results.

" “Retumn” is used to transfer back to the Input window for reviewing or modifying input data. 1f, after
T reviewing input data, you wish to return to the Output window without making any changes to the input
., data, click the icon. This saves time by not launching the calculation sequence if no data were

" changed.

Sensi’tiv1ty Menu

The Sensitivity menu is used to launch the Sensitivity Analysis window for analyzing
the impact of changes in all critical parameters (see Section 4.2). Same as @I

Help Menu

The Help menu provides assistance for ninning CTGROWTH. “Help |
Topics...” launches the CTGROWTH Help system from the Table of

Contents. Alternatively, clicking il or pressing [F1] opens the Help

system directly on a description of the current screen.
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Chapter 4. Qutput

4.2 SENSITIVITY ANALYSIS WINDOW
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in tﬁbing OD, wall thickness, material grade, internal pressure, and bending radius. These analyses will
‘ “intlicate the parameters that have the largest influence on CT growth as well as the most efficient approach(es)
~-~ww£m::‘(§ecreasing growth. This window is accessed by clicking |Sensitivity Analysis] at the bottom of the main
_Output window or the E] icon.

;;@Sensitivity Analysis window is used for evaluating the effects on CT growth of relatively small changes

@u Sensitivity Graph Windows. The results of the sensitivity analyses are presented for review and

" comparison in six tiled subwindows. Double-click on any graph to enlarge it to full screen. The windows
include:

|.  Wall Thickness. CT growth for the current wall thickness is compared to CT growth with wall
thickness 0.007 inches above and below the selected thickness (same nominal CT OD).

2. Internal Pressure. CT growth with the current internal pressure is compared to CT growth with 1000
psi above and below the current pressure. When the selected input pressure is less than 2000 psi, the
lower bounding curve will not be displayed because the model is based on test data from 1000 to 7000

psi. The same applies to input pressures above 6000 psi, for which case no upper bounding curve is
displayed.

3. VYield Strength. The impact of material yield strength is shown for three strengths: the current yield,
and 10,000 psi above and below the current yieid.

4.  OD. The selected CT OD is shown along with ODs 0.25 inches smaller and larger (with the same wall
thickness).

5. Bending Radius. The current bending radius (either the bending form radius for bending fixture cycle
calculations, or the gooseneck radius and reel diameter for full-scale trip calculations) is compared
to radii 14 inches (356 mm) above and below the current radius.
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5. Getting Help

5.1 CONTACTING MEI

For additional assistance with operation or application of CTGROWTH, contact:

Dr. Steve Yang or Chad Gao
Maurer Engineering Inc.
2916 West T.C. Jester Boulevard
Houston, Texas 77018-7098 U.S.A.

Telephone: (713) 683-8227
o Fax: (713) 683-6418
e E-mail: mei@maureng.com

PR

EPORTING PROBLEMS

r;_;f;éii'GROWTH version | has been carefully checked before its release; however, software bugs are a fact of life.
““———Please report any bugs you find and describe the input parameters and conditions selected when the problem
mmoccurred. Please check Appendix A first 1o determine whether the solution to your problem is described there.

MEL is also very appreciative of your comments and suggestions for improving CTGROWTH. Let us know
.. -4f there are additional features you would like to see added to the program. Though it may not be feasible to
= =s=icorporate every suggestion into the next version, many important improvements have been made to MEI
programs based directly on suggestions from users.

Please use the form on the next page to report bugs in the program, as well as suggestions on improving the
function and usefulness of CTGROWTH.
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Bug Report/Enhancement Suggestion Form

Name: Company:

Address: City: State:
Phone No.: Fax No.:

E-mail: Date:

[] Bug/Problem Report [] Enhancement Suggestion

Program Name and Version Number:

Bug/Problem Description or Suggested Enhancement:

QOther Comments:

Data/Parameters Causing Bug
[ Will be mailed on diskette L1 Will be faxed [ Attached [ None

Operating Svstem

MS-DOS Version No.: MS-Windows Version No.: (Win 3.1/Win 95)
Qs2 MS-Windows NT Version No.:
Other

Please mail, fax, or e-mail to:

Mr. Lee Chu
MAURER ENGINEERING INC.
2916 West T.C. Jester
Houston, TX 77018-7098
Ph: 713/683-8227 +« Fax: 713/683-6418
E-mail: mei@maureng.com
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Appendix A — Common Problems and Solutions

Specific problems related to installing and ranning MEI software are described in this section. These problems
have been reported by multiple users and are often related to computer settings and file locations.

A.1 INTERNATIONAL KEYBOARD SETTINGS

“Type Mismatch” Error

All computer software developed at Maurer Engineering Inc. is written using the U.S. Keyboard format. Under
this numeric standard, the 1000 separator is a comma, and the decimal separator is a period. Thus, the number
one thousand, two hundred and thirty-four and 22/100 is written as

1,234.22
Numbers input into MEI programs are stored in this format.

roblems have occurred for some of our clients who use the International Keyboard format, as is common in

certain countries in Europe and South America. Here, the same number would be written

1.234,22

where the 1000 separator is a period, and the decimal separator is a comma.

with the International Keyboard format find that their computers garble input data being loaded into MEI
programs. Often, a “Type Mismatch” error halts the program.

e This problem can be readily solved by changing the Windows numbers format from International to U.S.

e e

format. This can be accomplished as follows:

In Windows 3.x

Select the “Centrol Panel” icon from the Main menu screen. This is done by pointing the mouse to this
icon and double clicking. This brings up the “Control Panel” menu screen, as shown below.

Prog nm Manager - [Main] —

File MT—|

Scttings  Help
md M A&
Prals: Calor Forts

Intsgantional  Date/Time:

iz X &

Dirvenz Fax

[Specifies imamationel setingiliRibians
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A.3 PRINTER SELECTION

MEI programs support a wide range of monochrome and color printers. However, most programs written in
Visual Basic 3 (16-bit) do not provide options within the program for selecting individual printers. All print
jobs are sent to the current Windows default printer.

Changing Printers

If you wish to switch to a special printer, assign that printer as the Windows default printer before
running the MEI program. The default printer is selected under the Printers control window. This window
is accessed in Windows 95 by selecting Start — “Settings” - “Printers”. After the Printers window is open,
click once on the printer of interest to highlight it. Then, select “Set as Default” from the File menu.

Network Printers

Some users have experienced problems when trying to send output from MEI software to network printers.
~Nlost difficulties can be addressed by modifying the printer port entry. If a network printer will not print from
an'MEI program, follow these steps:

Select Start — “Settings” — “Printers™; then double-click the network printer icon.

: Select “Properties” from the Printer menu. Select the “Details™ tab from the Properties window (see
figure).

Place the cursor on the entry in the text box under Print to the following port:. Capy the text string by
, pressing control+C.

% . . B LazerSiM] P (+1
" Click the “Capture Printer Port...” button. b J[._Ir iidiacbiac

Select “LPT2” or “LPT3” under the Device
pull-down menu.

Click the Path: text box; then paste the text
string into the box by pressing control+V,
Click <OK> to close the “Capture Printer
Port” window.

7. On the “Details” window, pull down the list
of options under the Print to the following
port: box. Select the new entry {that you
just created) with “LPT2” or “LPT3”
followed by the text string copied and
pasted.

8.  Select <OK> and close all printer windows.

This procedure should allow printing to a
network printer, provided that printer is
also selected as the Windows default

printer.
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